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Q.1 Which of the following statements is/are true about NABARD?
I. NABARD was formed on the recommendation of Sivaraman Committee.
II. NABARD came into existence in 1980.
III. It was set up with an initial capital of ₹100 crore.

Ans 1. Only I

2. Only II and III

3. Only II

4. Only I and III

Question ID : 264330141455
Option 1 ID : 264330554155
Option 2 ID : 264330554158
Option 3 ID : 264330554156
Option 4 ID : 264330554157

Status : Answered
Chosen Option : 4

Q.2 The Indian Vice President is elected by an electoral college comprising members of
__________________.

Ans 1. Rajya Sabha, Lok Sabha and State Legislative Council

2. Lok Sabha and State Legislature

3. Rajya Sabha and State Legislative Assembly

4. both the houses of Parliament

Question ID : 264330110598
Option 1 ID : 264330434672
Option 2 ID : 264330434670
Option 3 ID : 264330434671
Option 4 ID : 264330434669

Status : Answered
Chosen Option : 1

Q.3 Which of the following is NOT a fundamental duty?
Ans 1. To safeguard public property

2. To value and preserve the rich heritage of the country’s composite culture

3. To promote cooperative society

4. To uphold and protect the sovereignty, unity and integrity of India

Question ID : 264330111515
Option 1 ID : 264330438145
Option 2 ID : 264330438147
Option 3 ID : 264330438148
Option 4 ID : 264330438146

Status : Answered
Chosen Option : 3
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Q.4 How many officials are there for looking after each Kabaddi match?
Ans 1. 6

2. 2

3. 3

4. 5

Question ID : 264330113772
Option 1 ID : 264330447175
Option 2 ID : 264330447176
Option 3 ID : 264330447174
Option 4 ID : 264330447173

Status : Not Answered
Chosen Option : --

Q.5 In which town of India did James Prinsep conduct the census in 1824?
Ans 1. Banaras

2. Allahabad 

3. Bombay 

4. Calcutta

Question ID : 264330130586
Option 1 ID : 264330511455
Option 2 ID : 264330511458
Option 3 ID : 264330511457
Option 4 ID : 264330511456

Status : Answered
Chosen Option : 2

Q.6 Where is the National Flag hoisted by the Prime Minister on every Independence Day?
Ans 1. Red Fort 

2.  Parliament House

3.  India Gate

4.  Gateway of India

Question ID : 264330106214
Option 1 ID : 264330417157
Option 2 ID : 264330417158
Option 3 ID : 264330417160
Option 4 ID : 264330417159

Status : Answered
Chosen Option : 1

Q.7 Which of the following states is associated with the devotional folk dance ‘Gambhira’?
Ans 1.  Rajasthan

2.  Bihar

3. Odisha  

4.  West Bengal

Question ID : 264330106188
Option 1 ID : 264330417055
Option 2 ID : 264330417054
Option 3 ID : 264330417053
Option 4 ID : 264330417056

Status : Answered
Chosen Option : 4
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Q.8 Murad Ali is a well-known _________ player.
Ans 1. guitar

2. sarangi

3. tabla

4. flute  

Question ID : 264330111961
Option 1 ID : 264330439929
Option 2 ID : 264330439932
Option 3 ID : 264330439931
Option 4 ID : 264330439930

Status : Answered
Chosen Option : 3

Q.9 Who among the following was the first Indian to conduct a major British orchestra in
1961? He was the Israel Philharmonic Orchestra's 'Music Director for Life'.

Ans 1. Zubin Mehta

2. Dr. Lakshminarayana Subramaniam

3. Ilaiyaraaja

4. AR Rahman

Question ID : 264330113235
Option 1 ID : 264330445028
Option 2 ID : 264330445027
Option 3 ID : 264330445026
Option 4 ID : 264330445025

Status : Answered
Chosen Option : 4

Q.10 Which of the following is NOT an independent constitutional body according to the
Indian Constitution?

Ans 1. UPSC

2. NITI Aayog

3. Election Commission

4. State Public Service Commission

Question ID : 264330173471
Option 1 ID : 264330680364
Option 2 ID : 264330680366
Option 3 ID : 264330680363
Option 4 ID : 264330680365

Status : Answered
Chosen Option : 2

Q.11 Which of the following Articles of the Indian Constitution is related with organisation
of village panchayats?

Ans 1. Article40

2. Article38

3. Article39

4. Article 37

Question ID : 264330180056
Option 1 ID : 264330706210
Option 2 ID : 264330706208
Option 3 ID : 264330706209
Option 4 ID : 264330706207

Status : Answered
Chosen Option : 1
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Q.12 The ‘Shiksha Karmi’ initiative and the ‘Lok Jumbish’ programme are schemes that
helped increase the literacy rate of which state in India?

Ans 1. Madhya Pradesh

2. Gujarat 

3. Mizoram 

4. Rajasthan 

Question ID : 264330130595
Option 1 ID : 264330511493
Option 2 ID : 264330511492
Option 3 ID : 264330511491
Option 4 ID : 264330511494

Status : Answered
Chosen Option : 3

Q.13 The main objective of which of the following schemes is to support sustainable
production in the agriculture sector by providing financial assistance to farmers
suffering crop loss/damage arising out of unforeseen events?

Ans 1. Pradhan Mantri Fasal Bima Yojana

2. Paramparagat Krishi Vikas Yojana

3. Pradhan Mantri Krishi Sinchai Yojana

4. Gramin Bhandaran Yojana

Question ID : 264330120360
Option 1 ID : 264330471693
Option 2 ID : 264330471694
Option 3 ID : 264330471692
Option 4 ID : 264330471691

Status : Answered
Chosen Option : 1

Q.14 Who described Archimedes' method of finding the specific gravity of substances
using a balance in the treatise ‘The Little Balance’?

Ans 1. Galileo Galilei

2. Michael Faraday

3. Daniel Bernoulli

4. Albert Einstein

Question ID : 264330177866
Option 1 ID : 264330697552
Option 2 ID : 264330697553
Option 3 ID : 264330697554
Option 4 ID : 264330697551

Status : Answered
Chosen Option : 3
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Q.15 Sultan Muhammad Bin Tughluq appointed ____________, a wine distiller, to a high
administrative post in the Delhi Sultanate.

Ans 1. Aziz Khummar

2. Manka Tabbakh

3. Ladha

4. Firuz Hajjam

Question ID : 264330182262
Option 1 ID : 264330714874
Option 2 ID : 264330714872
Option 3 ID : 264330714873
Option 4 ID : 264330714871

Status : Not Answered
Chosen Option : --

Q.16 The Rajya Sabha should consist of NOT more than _______________ members.
Ans 1. 240

2. 245

3. 250

4. 238

Question ID : 264330120180
Option 1 ID : 264330470978
Option 2 ID : 264330470976
Option 3 ID : 264330470975
Option 4 ID : 264330470977

Status : Answered
Chosen Option : 3

Q.17 In which of the following years was Subash Chandra Bose appointed as the President
of the Indian Independence League?

Ans 1. 1941

2. 1944

3. 1942

4. 1943

Question ID : 264330118607
Option 1 ID : 264330465682
Option 2 ID : 264330465679
Option 3 ID : 264330465681
Option 4 ID : 264330465680

Status : Answered
Chosen Option : 3

Q.18 Which thermostable enzyme hydrolyses starch during the cooking of sweet potatoes?
Ans 1. Pectinase

2. Exocellulases

3. β-amylase

4. Lipase

Question ID : 264330131006
Option 1 ID : 264330513138
Option 2 ID : 264330513137
Option 3 ID : 264330513135
Option 4 ID : 264330513136

Status : Not Answered
Chosen Option : --
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Q.19 Harmika is a _________ Buddhist railing, from which a shaft rises and that holds the
imperial umbrella.

Ans 1. square  

2.  rectangular

3. cylindrical  

4.  circular

Question ID : 264330106356
Option 1 ID : 264330417727
Option 2 ID : 264330417728
Option 3 ID : 264330417725
Option 4 ID : 264330417726

Status : Answered
Chosen Option : 4

Q.20 Which of the following is causative factor for oral cancer?
Ans 1. Spicy food 

2.  Tobacco

3. Sugar

4.  Excess salt

Question ID : 264330118274
Option 1 ID : 264330464911
Option 2 ID : 264330464913
Option 3 ID : 264330464912
Option 4 ID : 264330464914

Status : Answered
Chosen Option : 2

Q.21 How many types of ministers are there in the Council of Ministers?
Ans 1. 5

2. 6

3. 3

4. 4

Question ID : 264330173517
Option 1 ID : 264330680549
Option 2 ID : 264330680550
Option 3 ID : 264330680547
Option 4 ID : 264330680548

Status : Answered
Chosen Option : 3

Q.22 Who among the following is an American tennis player who wrote ‘Open: An
autobiography’?

Ans 1. Pete Sampras

2. Rod Laver

3. Andre Agassi

4. Ivan Lendl

Question ID : 26433086907
Option 1 ID : 264330341269
Option 2 ID : 264330341271
Option 3 ID : 264330341270
Option 4 ID : 264330341272

Status : Not Answered
Chosen Option : --
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Q.23 Which of the following is an essential feature of the Green Revolution?
Ans 1. Increase in multi-fold international trade.

2. Increase in the role and responsibility of the government.

3. Good quality labour can increase industrial productivity.

4. HYV seeds have led to a substantial rise in crop productivity.

Question ID : 264330174152
Option 1 ID : 264330683049
Option 2 ID : 264330683050
Option 3 ID : 264330683047
Option 4 ID : 264330683048

Status : Answered
Chosen Option : 4

Q.24 The ‘slash and burn’ agriculture is known as ________ in Rajasthan state.
Ans 1. Waltre

2. Roca

3. Dipa

4. Podu

Question ID : 264330181232
Option 1 ID : 264330710854
Option 2 ID : 264330710853
Option 3 ID : 264330710851
Option 4 ID : 264330710852

Status : Answered
Chosen Option : 1

Q.25 Harshavardhana, the ruler of Kannauj in 7th century CE, was the king of which of the
following dynasties?

Ans 1. Pushyabhuti

2. Vakataka

3. Chalukya

4. Maukhari

Question ID : 264330183234
Option 1 ID : 264330718669
Option 2 ID : 264330718671
Option 3 ID : 264330718668
Option 4 ID : 264330718670

Status : Answered
Chosen Option : 1

Q.26 The Thanksgiving Festival of Nawala that is dedicated to Lord Shiva is majorly
celebrated in which city of Himachal Pradesh?

Ans 1. Chamba

2. Dharamshala

3. Shimla

4. Kangra

Question ID : 264330132413
Option 1 ID : 264330518749
Option 2 ID : 264330518750
Option 3 ID : 264330518748
Option 4 ID : 264330518747

Status : Not Answered
Chosen Option : --
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Q.27 In India, the Young Men’s Christian Association (YMCA) at ___________ introduced
basketball for the first time.

Ans 1. Kolkata

2. Ranchi

3. Mumbai

4. Jamshedpur

Question ID : 264330119274
Option 1 ID : 264330467384
Option 2 ID : 264330467385
Option 3 ID : 264330467386
Option 4 ID : 264330467383

Status : Not Answered
Chosen Option : --

Q.28 In which year did the sepoy revolt take place in Vellore?
Ans 1. 1795 CE

2. 1824 CE

3. 1806 CE

4. 1856 CE

Question ID : 264330114042
Option 1 ID : 264330448253
Option 2 ID : 264330448256
Option 3 ID : 264330448254
Option 4 ID : 264330448255

Status : Answered
Chosen Option : 4

Q.29 How many total jumps are there in a 3000 m steeplechase race?
Ans 1. 36

2. 33

3. 35

4. 34

Question ID : 264330110392
Option 1 ID : 264330433847
Option 2 ID : 264330433845
Option 3 ID : 264330433846
Option 4 ID : 264330433848

Status : Not Answered
Chosen Option : --

Q.30 Which of the following has NOT occurred after the liberalisation of economic policies
under the New Economic Policies (NEP) in 1991?

Ans 1. Increase in India’s share of exports in world trade

2. Significant increase in India’s foreign exchange reserves

3. Increase in inflows from foreign direct investment

4. A massive increase in the share of agriculture in India’s gross domestic product

Question ID : 264330111599
Option 1 ID : 264330438484
Option 2 ID : 264330438481
Option 3 ID : 264330438482
Option 4 ID : 264330438483

Status : Answered
Chosen Option : 4
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Q.31 Microfinance programmes were first created by Nobel prize winning Economist
Muhummad Yunus in what decade?

Ans 1. 1960s

2. 1990s

3. 1970s

4. 1950s

Question ID : 264330117570
Option 1 ID : 264330462306
Option 2 ID : 264330462308
Option 3 ID : 264330462307
Option 4 ID : 264330462305

Status : Answered
Chosen Option : 2

Q.32 Birsa Munda hockey stadium is situated in _________ .
Ans 1. Jharkhand

2. Chhattisgarh

3. Haryana

4. Odisha

Question ID : 264330132540
Option 1 ID : 264330519257
Option 2 ID : 264330519256
Option 3 ID : 264330519258
Option 4 ID : 264330519255

Status : Answered
Chosen Option : 4

Q.33 Who among the following was the founder and director of ‘Darpana Academy of
Performing Arts’ in Ahmedabad that trains students in dance, drama, music and
puppetry?

Ans 1. Mrinalini Sarabhai 

2. Padma Subrahmanyam

3. Shovana Narayan

4. Sonal Mansingh

Question ID : 264330111977
Option 1 ID : 264330439993
Option 2 ID : 264330439996
Option 3 ID : 264330439994
Option 4 ID : 264330439995

Status : Answered
Chosen Option : 1
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Q.34 Which Article of the Constitution of India says that Directive Principles of State Policy
are fundamental in the governance of the country and it shall be the duty of the state
to apply these in making laws?

Ans 1. Article 39

2. Article 38

3. Article 35

4. Article 37

Question ID : 264330130452
Option 1 ID : 264330510922
Option 2 ID : 264330510921
Option 3 ID : 264330510919
Option 4 ID : 264330510920

Status : Answered
Chosen Option : 4

Q.35 As per Census 2011, which of the following states has the highest percentage of
Scheduled Tribe population in the country?

Ans 1. Madhya Pradesh

2. Nagaland

3. Uttar Pradesh

4. Mizoram

Question ID : 264330183019
Option 1 ID : 264330717811
Option 2 ID : 264330717809
Option 3 ID : 264330717810
Option 4 ID : 264330717808

Status : Answered
Chosen Option : 1

Q.36 The Tungabhadra, the Koyana and the Bhima are major tributaries of which Peninsular
river?

Ans 1. Krishna

2. Godavari

3. Narmada

4. Kaveri

Question ID : 264330176012
Option 1 ID : 264330690343
Option 2 ID : 264330690344
Option 3 ID : 264330690345
Option 4 ID : 264330690346

Status : Answered
Chosen Option : 2

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


Q.37 At which place did the Congress declare the resolution of Purna Swaraj in its session
in 1929?

Ans 1. Bombay

2. Karachi 

3. Lahore

4. Madras 

Question ID : 264330123745
Option 1 ID : 264330485016
Option 2 ID : 264330485015
Option 3 ID : 264330485018
Option 4 ID : 264330485017

Status : Answered
Chosen Option : 3

Q.38 What is the range of mesosphere?
Ans 1. 0-10 km

2. 10-30 km

3. 50-100 km

4. 50-80 km

Question ID : 264330120082
Option 1 ID : 264330470583
Option 2 ID : 264330470584
Option 3 ID : 264330470586
Option 4 ID : 264330470585

Status : Answered
Chosen Option : 3

Q.39 The branch of geology exploring how rocks bend in reaction to forces within the
Earth’s interior is called:

Ans 1. basic geology

2. mountain geology

3. rock geology

4. structural geology

Question ID : 264330131815
Option 1 ID : 264330516361
Option 2 ID : 264330516362
Option 3 ID : 264330516360
Option 4 ID : 264330516359

Status : Answered
Chosen Option : 4

Q.40 Shri Narayana Guru, who belonged to the Ezhava caste, started his social reform
movement in the modern state of:

Ans 1. Maharashtra

2. Odisha

3. Punjab

4. Kerala

Question ID : 264330119747
Option 1 ID : 264330469264
Option 2 ID : 264330469265
Option 3 ID : 264330469266
Option 4 ID : 264330469263

Status : Not Answered
Chosen Option : --

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


Q.41 The term ‘Takshan’ in the Vedic period was used for ________.
Ans 1. Carpenter

2. Kulapa

3. Senani

4. Rathakara

Question ID : 264330117681
Option 1 ID : 264330462720
Option 2 ID : 264330462722
Option 3 ID : 264330462719
Option 4 ID : 264330462721

Status : Not Answered
Chosen Option : --

Q.42 General Agreement on Tariffs and Trade was formalised in the year:
Ans 1. 1991

2. 1947 

3. 2002

4. 1995

Question ID : 264330111580
Option 1 ID : 264330438406
Option 2 ID : 264330438405
Option 3 ID : 264330438408
Option 4 ID : 264330438407

Status : Answered
Chosen Option : 3

Q.43 Identify the FALSE statement(s).
A. In the context of Green Revolution HYV stands for Hybrid Yielding Variety.
B. Fallowing is a practice of leaving land uncultivated for some time for it to regain its
fertility.

Ans 1. Only B

2. Only A

3. Neither A nor B

4. Both A and B

Question ID : 264330109114
Option 1 ID : 264330428734
Option 2 ID : 264330428733
Option 3 ID : 264330428736
Option 4 ID : 264330428735

Status : Answered
Chosen Option : 2

Q.44 Who is the author of ‘Half Girlfriend and One Indian Girl’?
Ans 1. Amit Chaudhuri

2. Kiran Desai

3. Jeet Thayil

4. Chetan Bhagat

Question ID : 26433071708
Option 1 ID : 264330281258
Option 2 ID : 264330281257
Option 3 ID : 264330281256
Option 4 ID : 264330281259

Status : Answered
Chosen Option : 4
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Q.45 Muhammad bin Tughlaq appointed Ibn Battuta to the post of the _________ in Delhi.
Ans 1. Amalguzar

2. Qazi

3. Shiqdar

4. Kotwal

Question ID : 264330111376
Option 1 ID : 264330437590
Option 2 ID : 264330437592
Option 3 ID : 264330437591
Option 4 ID : 264330437589

Status : Answered
Chosen Option : 2

Q.46 Beti Bachao, Beti Padhao Yojana is a campaign under the Government of India that
was established for generating awareness and improving the efficiency of the welfare
services intended for ________ in India.

Ans 1. boys

2. girls

3. children

4. both boys and girls

Question ID : 264330110011
Option 1 ID : 264330432321
Option 2 ID : 264330432322
Option 3 ID : 264330432324
Option 4 ID : 264330432323

Status : Answered
Chosen Option : 2

Q.47 Nongkrem and Laho are the popular dances of which of the following states?
Ans 1.  Manipur

2.  Arunachal Pradesh

3. Meghalaya 

4.  Assam

Question ID : 264330110417
Option 1 ID : 264330433948
Option 2 ID : 264330433946
Option 3 ID : 264330433945
Option 4 ID : 264330433947

Status : Answered
Chosen Option : 1

Q.48 Fugdi dance is commonly performed during which of these festivals?
Ans 1. Ganesh Chaturthi

2. Holi

3. Navratri

4. Deepawali

Question ID : 264330109289
Option 1 ID : 264330429435
Option 2 ID : 264330429434
Option 3 ID : 264330429433
Option 4 ID : 264330429436

Status : Answered
Chosen Option : 2
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Q.49 The Five Kingdom Classification of living organism was first proposed by:
Ans 1. James A White

2. Charles Darwin

3. RH Whittaker

4. Aristotle

Question ID : 264330173660
Option 1 ID : 264330681122
Option 2 ID : 264330681121
Option 3 ID : 264330681120
Option 4 ID : 264330681119

Status : Answered
Chosen Option : 3

Q.50 Humayun Tomb, which is located in _________ is an example of Mughal architecture
inspired by Persian architecture.

Ans 1.  Bengaluru

2. Hyderabad

3.  Jaipur

4. Delhi

Question ID : 264330106249
Option 1 ID : 264330417300
Option 2 ID : 264330417298
Option 3 ID : 264330417297
Option 4 ID : 264330417299

Status : Answered
Chosen Option : 4

Q.1 Select the option that is related to the fifth letter cluster in the same way as the second
letter cluster is related to the first letter cluster and the fourth letter cluster is related to
the third letter cluster.
RJCZ : KPVF :: DJVE : WPOK :: PGCS : ?

Ans 1. MCJA

2. YGBE

3. IMVY

4. LKSP

Question ID : 26433074690
Option 1 ID : 264330292851
Option 2 ID : 264330292850
Option 3 ID : 264330292848
Option 4 ID : 264330292849

Status : Answered
Chosen Option : 3

Section : Reasoning
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Q.2 Select the correct mirror image of the given figure when the mirror is placed at MN as
shown below.

Ans
1. 

2. 

3. 

4. 

Question ID : 264330117835
Option 1 ID : 264330463155
Option 2 ID : 264330463158
Option 3 ID : 264330463157
Option 4 ID : 264330463156

Status : Answered
Chosen Option : 1

Q.3 Three different positions of the same dice are shown. Find the number on the face
opposite the face showing ‘2’.

Ans 1. 3 

2. 4 

3. 1 

4. 5 

Question ID : 264330116961
Option 1 ID : 264330459928
Option 2 ID : 264330459926
Option 3 ID : 264330459927
Option 4 ID : 264330459925

Status : Answered
Chosen Option : 2

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


Q.4 Two statements are given, followed by two conclusions numbered I and II. Assuming
the statements to be true, even if they seem to be at variance with commonly known
facts, decide which of the conclusions logically follow(s) from the statements.
Statements:
All surveys are research.
Some surveys are books.
Conclusions:
I. Some research are surveys.
II. All books are research.

Ans 1. Only Conclusion II follows.

2. Only Conclusion I follows.

3. Both Conclusions I and II follow.

4. Neither Conclusion I nor II follows.

Question ID : 26433081679
Option 1 ID : 264330320550
Option 2 ID : 264330320549
Option 3 ID : 264330320551
Option 4 ID : 264330320552

Status : Answered
Chosen Option : 2

Q.5

Ans 1. 

2. 

3. 

4. 

Question ID : 26433080791
Option 1 ID : 264330317098
Option 2 ID : 264330317097
Option 3 ID : 264330317100
Option 4 ID : 264330317099

Status : Answered
Chosen Option : 2
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Q.6 Given below is a series of figures – A, B, C and D which follow a particular pattern.
Which of the given option figures should come in place of E to continue the series?

Ans

1. 

2. 

3. 

4. 

Question ID : 264330111288
Option 1 ID : 264330437238
Option 2 ID : 264330437239
Option 3 ID : 264330437240
Option 4 ID : 264330437237

Status : Answered
Chosen Option : 4

Q.7 Select the correct mirror image of the given combination when the mirror is placed at
'PQ' as shown below.

Ans
1. 

2. 

3. 

4. 

Question ID : 264330129810
Option 1 ID : 264330508471
Option 2 ID : 264330508472
Option 3 ID : 264330508474
Option 4 ID : 264330508473

Status : Answered
Chosen Option : 1
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Q.8 Select the figure from the given options that will replace the question mark (?) in the
figure given below and complete the pattern.

Ans

1. 

2. 

3. 

4. 

Question ID : 264330111709
Option 1 ID : 264330438922
Option 2 ID : 264330438924
Option 3 ID : 264330438923
Option 4 ID : 264330438921

Status : Answered
Chosen Option : 3

Q.9 Which two signs should be interchanged to make the given equation correct?
264 ÷ 4 × 7 = 87 − 370 + 5

Ans 1. = and −

2. = and ×

3. = and +

4. = and ÷

Question ID : 26433085737
Option 1 ID : 264330336651
Option 2 ID : 264330336650
Option 3 ID : 264330336649
Option 4 ID : 264330336652

Status : Answered
Chosen Option : 1

https://applink.adda247.com/d/XhqWf9lSap
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Q.10 Select the correct mirror image of the given combination when the mirror is placed at
'XY' as shown below.

Ans 1. 

2. 

3. 

4. 

Question ID : 264330129691
Option 1 ID : 264330508133
Option 2 ID : 264330508132
Option 3 ID : 264330508130
Option 4 ID : 264330508131

Status : Answered
Chosen Option : 4

Q.11 In a certain code language, ‘BLESSING’ is written as ‘ELJQQFJZ’ and 'OVERNIGHT' is
written as ‘RFEJLPFTP’. How will ‘HAMPER’ be written in that language?

Ans 1. QFNNBJ

2. FBKNFP

3. PFNKBF

4. TBORJE

Question ID : 26433092580
Option 1 ID : 264330363610
Option 2 ID : 264330363609
Option 3 ID : 264330363611
Option 4 ID : 264330363612

Status : Answered
Chosen Option : 3

Q.12 Select the correct combination of mathematical signs to sequentially replace the *
signs and to balance the given equation.
98 * 49 * 7 * 74 * 55 * 3

Ans 1. ÷,−, +,×, =

2. −, ÷, +, =,×

3. −, ÷, +,×, =

4. ÷,−,×, +, =

Question ID : 26433085714
Option 1 ID : 264330336557
Option 2 ID : 264330336558
Option 3 ID : 264330336559
Option 4 ID : 264330336560

Status : Answered
Chosen Option : 2

https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap


Q.13 Three different positions of the same dice are shown. Select the symbol that will be on
the face opposite to the face showing ‘L’.

Ans 1. %

2. @

3. &

4. #

Question ID : 264330117421
Option 1 ID : 264330461726
Option 2 ID : 264330461725
Option 3 ID : 264330461728
Option 4 ID : 264330461727

Status : Answered
Chosen Option : 4

Q.14 Select the option that is related to the fourth number in the same way as the first
number is related to the second number and the fifth number is related to the sixth
number.
1260 : 1890 :: ? : 2160 :: 1882 : 2823

Ans 1. 1280

2. 1440

3. 1480

4. 1860

Question ID : 26433052021
Option 1 ID : 264330203387
Option 2 ID : 264330203388
Option 3 ID : 264330203386
Option 4 ID : 264330203389

Status : Answered
Chosen Option : 2

https://applink.adda247.com/d/XhqWf9lSap
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Q.15

Ans 1. 

2. 

3. 

4. 

Question ID : 26433080773
Option 1 ID : 264330317027
Option 2 ID : 264330317028
Option 3 ID : 264330317025
Option 4 ID : 264330317026

Status : Answered
Chosen Option : 4

Q.16

Ans 1. 6

2. 5

3. 1

4. 3

Question ID : 264330110549
Option 1 ID : 264330434473
Option 2 ID : 264330434474
Option 3 ID : 264330434475
Option 4 ID : 264330434476

Status : Answered
Chosen Option : 2

https://applink.adda247.com/d/XhqWf9lSap
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Q.17

Ans 1. 14

2. 13

3. 17

4. 20

Question ID : 26433091706
Option 1 ID : 264330360190
Option 2 ID : 264330360189
Option 3 ID : 264330360191
Option 4 ID : 264330360192

Status : Answered
Chosen Option : 3

Q.18 Which of the following letter clusters will replace the question mark (?) in the given
series to make it logically complete?
IKN, GHL, EEJ, CBH, ?

Ans 1. AZF

2. AXE

3. AYF

4. AYE

Question ID : 264330102228
Option 1 ID : 264330401377
Option 2 ID : 264330401380
Option 3 ID : 264330401379
Option 4 ID : 264330401378

Status : Answered
Chosen Option : 1

https://applink.adda247.com/d/XhqWf9lSap
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Q.19 Select the figure that will come next in the following figure series.

Ans

1. 

2. 

3. 

4. 

Question ID : 264330129650
Option 1 ID : 264330507969
Option 2 ID : 264330507966
Option 3 ID : 264330507967
Option 4 ID : 264330507968

Status : Answered
Chosen Option : 3

https://applink.adda247.com/d/XhqWf9lSap
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Q.20 Which figure should replace the question mark (?) if the series were to be continued?

Ans

1. 

2. 

3. 

4. 

Question ID : 264330130794
Option 1 ID : 264330512289
Option 2 ID : 264330512290
Option 3 ID : 264330512288
Option 4 ID : 264330512287

Status : Answered
Chosen Option : 3

https://applink.adda247.com/d/XhqWf9lSap
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Q.21

Ans

1. 

2. 

3. 

4. 

Question ID : 26433080616
Option 1 ID : 264330316400
Option 2 ID : 264330316398
Option 3 ID : 264330316397
Option 4 ID : 264330316399

Status : Answered
Chosen Option : 3

Q.22 Select the number from among the given options that can replace the question mark
(?) in the following series.

10, 18, 42, 114, 330, ?
Ans 1. 978

2. 876

3. 678

4. 545

Question ID : 264330109755
Option 1 ID : 264330431299
Option 2 ID : 264330431300
Option 3 ID : 264330431298
Option 4 ID : 264330431297

Status : Answered
Chosen Option : 1

https://applink.adda247.com/d/XhqWf9lSap
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Q.23 L, M, N, O, P, R and S are sitting in a straight row, facing north. O is exactly between L
and N. M is exactly between S and P. Only two people sit to the left of O. Who among
the following sits at the extreme left end of the row?

Ans 1.  L

2.  S

3.  P

4.  R

Question ID : 26433087018
Option 1 ID : 264330341716
Option 2 ID : 264330341714
Option 3 ID : 264330341715
Option 4 ID : 264330341713

Status : Answered
Chosen Option : 4

Q.24 Select the set in which the numbers are related in the same way as are the numbers of
the following sets.

(NOTE : Operations should be performed on the whole numbers, without breaking
down the numbers into its constituent digits. E.g. 13 – Operations on 13 such as
adding /deleting /multiplying etc. to 13 can be performed. Breaking down 13 into 1 and
3 and then performing mathematical operations on 1 and 3 is not allowed.)
(63, 9, 27)
(105, 15, 45)

Ans 1. (149, 21, 63)

2. (149, 21, 65)

3. (147, 21, 65)

4. (147, 21, 63)

Question ID : 26433097193
Option 1 ID : 264330381469
Option 2 ID : 264330381470
Option 3 ID : 264330381471
Option 4 ID : 264330381472

Status : Answered
Chosen Option : 4

https://applink.adda247.com/d/XhqWf9lSap
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Q.25

Ans

1. 

2. 

3. 

4. 

Question ID : 26433085565
Option 1 ID : 264330335963
Option 2 ID : 264330335964
Option 3 ID : 264330335962
Option 4 ID : 264330335961

Status : Answered
Chosen Option : 1

Section : Numerical Ability
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Q.1

Ans
1. 

2. 

3. 

4. 

Question ID : 264330112072
Option 1 ID : 264330440375
Option 2 ID : 264330440376
Option 3 ID : 264330440374
Option 4 ID : 264330440373

Status : Answered
Chosen Option : 4

Q.2 A person buys a car at 25% discount on the marked price and sells it at 20% higher
than the marked price. What is the actual gain percentage?

Ans 1. 40%

2. 60%

3. 25%

4. 20%

Question ID : 264330119332
Option 1 ID : 264330467617
Option 2 ID : 264330467618
Option 3 ID : 264330467615
Option 4 ID : 264330467616

Status : Answered
Chosen Option : 2

Q.3 A sum of ₹9,500 becomes ₹11,704.95 in 2 years at compound interest. What is the rate
of interest?

Ans 1. 

2. 

3. 

4. 

Question ID : 264330104523
Option 1 ID : 264330410396
Option 2 ID : 264330410395
Option 3 ID : 264330410394
Option 4 ID : 264330410393

Status : Answered
Chosen Option : 1

https://applink.adda247.com/d/XhqWf9lSap
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Q.4 If 3x ∶  y ∶  2z = 6 ∶  5 ∶  4 and 5x - 3y + 4z = 48, then find the value of 2z.
Ans 1. 64

2. 48

3. 60

4. 54

Question ID : 264330130093
Option 1 ID : 264330509606
Option 2 ID : 264330509603
Option 3 ID : 264330509605
Option 4 ID : 264330509604

Status : Answered
Chosen Option : 1

Q.5

Ans 1. 5%

2. 4%

3. 6%

4. 7%

Question ID : 264330133281
Option 1 ID : 264330522173
Option 2 ID : 264330522171
Option 3 ID : 264330522172
Option 4 ID : 264330522174

Status : Answered
Chosen Option : 1

Q.6 The area of a triangle whose sides are of lengths 5 cm, 6 cm and 8 cm is:
Ans 1. 10.92 cm2

2. 18.92 cm2

3. 16.89 cm2

4. 14.98 cm2

Question ID : 264330104540
Option 1 ID : 264330410464
Option 2 ID : 264330410462
Option 3 ID : 264330410461
Option 4 ID : 264330410463

Status : Answered
Chosen Option : 4

https://applink.adda247.com/d/XhqWf9lSap
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Q.7 A has completed two-third of a job in 8 days, and B completes the rest of the job in 20
days. In how many days can they together complete the job?

Ans 1. 20

2. 12

3. 10

4. 8

Question ID : 264330104535
Option 1 ID : 264330410441
Option 2 ID : 264330410444
Option 3 ID : 264330410443
Option 4 ID : 264330410442

Status : Answered
Chosen Option : 3

Q.8 The radius and height of a cone are 4 cm and 3 cm, respectively. Find the volume of
the cone.

Ans 1. 12π cm3

2. 16π cm3

3. 8π cm3

4. 48π cm3

Question ID : 264330111496
Option 1 ID : 264330438070
Option 2 ID : 264330438071
Option 3 ID : 264330438069
Option 4 ID : 264330438072

Status : Answered
Chosen Option : 2

Q.9 If Ram gets a discount of 12% on the marked price of a fan, he saves ₹600. How much
did Ram pay for the fan?

Ans 1. ₹4,400

2. ₹3,300

3. ₹3,600

4. ₹4,600

Question ID : 264330130088
Option 1 ID : 264330509584
Option 2 ID : 264330509583
Option 3 ID : 264330509586
Option 4 ID : 264330509585

Status : Answered
Chosen Option : 1

https://applink.adda247.com/d/XhqWf9lSap
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Q.10 Twin prime numbers are the prime numbers whose difference is always equal to 2. The
number of twin primes between 35 and 100 is:

Ans 1. 3

2. 4

3. 1

4. 2

Question ID : 264330104387
Option 1 ID : 264330409851
Option 2 ID : 264330409849
Option 3 ID : 264330409850
Option 4 ID : 264330409852

Status : Answered
Chosen Option : 1

Q.11 A 300 m long train crosses a platform which is five times of its length, in 7 minutes 40
sec. What is the speed of the train?

Ans
1. 

2. 

3. 

4. 

Question ID : 264330122991
Option 1 ID : 264330482027
Option 2 ID : 264330482028
Option 3 ID : 264330482030
Option 4 ID : 264330482029

Status : Answered
Chosen Option : 3

Q.12 Three numbers which are co-prime to each other are such that the product of the first
two is 391 and that of the last two is 943. Find the middle number.

Ans 1. 17

2. 23

3. 41

4. 19

Question ID : 264330111444
Option 1 ID : 264330437861
Option 2 ID : 264330437863
Option 3 ID : 264330437862
Option 4 ID : 264330437864

Status : Answered
Chosen Option : 2

https://applink.adda247.com/d/XhqWf9lSap
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Q.13 What is the average of the following numbers?
4, 3, 7, −3, 0, −5, −7, 5, −6, 0, −4, 6

Ans 1. 4

2. 2

3. 1

4. 0

Question ID : 264330126093
Option 1 ID : 264330494047
Option 2 ID : 264330494046
Option 3 ID : 264330494045
Option 4 ID : 264330494044

Status : Answered
Chosen Option : 4

Q.14 What is the smallest number which, when divided by 15, 17 and 19, leaves remainder
4, 6 and 8, respectively?

Ans 1. 4845

2. 4548

3. 4832

4. 4834

Question ID : 264330103915
Option 1 ID : 264330407961
Option 2 ID : 264330407963
Option 3 ID : 264330407964
Option 4 ID : 264330407962

Status : Answered
Chosen Option : 4

Q.15 Venu invested a certain amount in shares. The shares rose by 25% on the first day, fell
by 8% on the second day and fell by 10% the next day. The percentage profit or loss
made by Venu is:

Ans 1. 4.5%, profit

2. 4.5%, loss

3. 3.5%, profit

4. 3.5%, loss

Question ID : 264330129399
Option 1 ID : 264330506964
Option 2 ID : 264330506963
Option 3 ID : 264330506965
Option 4 ID : 264330506962

Status : Answered
Chosen Option : 3

Section : Computer Proficiency
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Q.1 Which of the following devices is most commonly used to connect multiple computers
within a Local Area Network (LAN) and also efficiently manage data traffic by only
sending data to the device it is intended for?

Ans 1. Switch

2. Gateway

3. Router

4. Modem

Question ID : 264330182467
Option 1 ID : 264330715662
Option 2 ID : 264330715661
Option 3 ID : 264330715660
Option 4 ID : 264330715659

Status : Answered
Chosen Option : 3

Q.2 How do you access the ‘Save As’ function in MS Word 365?
Ans 1. By clicking on the ‘Save’ icon

2. By going to the File tab and selecting ‘Save As’

3. By using the keyboard shortcut ‘Ctrl + S’

4. By right-clicking on the document and selecting ‘Save As’

Question ID : 264330180850
Option 1 ID : 264330709363
Option 2 ID : 264330709365
Option 3 ID : 264330709364
Option 4 ID : 264330709366

Status : Answered
Chosen Option : 4

Q.3 Which of the following shortcut keys is used to open the help tab in the menu bar in
MS Word 365?

Ans 1. F12

2. F1

3. F4

4. F2

Question ID : 264330178603
Option 1 ID : 264330700442
Option 2 ID : 264330700439
Option 3 ID : 264330700441
Option 4 ID : 264330700440

Status : Answered
Chosen Option : 2

https://applink.adda247.com/d/XhqWf9lSap
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Q.4 The symbol which is used to separate the user name and email server parts of an
email is:

Ans 1. @

2. $

3. %

4. #

Question ID : 264330175928
Option 1 ID : 264330690007
Option 2 ID : 264330690010
Option 3 ID : 264330690009
Option 4 ID : 264330690008

Status : Answered
Chosen Option : 1

Q.5 In MS-Excel 365, which option allows you to sort data based on multiple columns
simultaneously?

Ans 1. AutoFilter

2. Quick Sort

3. Custom Sort

4. Sort A to Z

Question ID : 264330181815
Option 1 ID : 264330713108
Option 2 ID : 264330713110
Option 3 ID : 264330713107
Option 4 ID : 264330713109

Status : Answered
Chosen Option : 3

Q.6 How can you delete a row or column in MS-Excel 365?
Ans 1. Use the Ctrl+D keyboard shortcut.

2. Right-click on the row or column and choose ‘Delete’ from the context menu.

3. Use the Ctrl+H keyboard shortcut.

4. Go to the ‘Insert’ tab on the Excel ribbon and click on ‘Delete’.

Question ID : 264330173572
Option 1 ID : 264330680769
Option 2 ID : 264330680767
Option 3 ID : 264330680770
Option 4 ID : 264330680768

Status : Answered
Chosen Option : 2

Q.7 What is the purpose of the ‘Center Align’ text alignment option in Microsoft Word 365?
Ans 1. It aligns the text along the right margin

2. It centres the text horizontally between the margins

3. It aligns the text along the left margin

4. It adds extra spacing between words

Question ID : 264330180730
Option 1 ID : 264330708888
Option 2 ID : 264330708889
Option 3 ID : 264330708887
Option 4 ID : 264330708890

Status : Answered
Chosen Option : 2

https://applink.adda247.com/d/XhqWf9lSap
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Q.8 In MS Word 365 how can you access the spelling and grammar check feature in
Microsoft Word?

Ans 1. Go to the ‘Home’ tab and click on ‘Spelling & Grammar’

2. Go to the ‘Insert’ tab and click on ‘Spelling & Grammar’

3. Go to the ‘Review’ tab and click on ‘Spelling & Grammar’

4. Go to the ‘View’ tab and click on ‘Spelling & Grammar’

Question ID : 264330173585
Option 1 ID : 264330680820
Option 2 ID : 264330680822
Option 3 ID : 264330680821
Option 4 ID : 264330680819

Status : Answered
Chosen Option : 3

Q.9 Which of the following tabs on the ribbon in MS Word 365 provides options for
formatting text, such as font style and size?

Ans 1. Insert

2. File

3. Home

4. Page Layout

Question ID : 264330180853
Option 1 ID : 264330709377
Option 2 ID : 264330709375
Option 3 ID : 264330709376
Option 4 ID : 264330709378

Status : Answered
Chosen Option : 3

Q.10 In MS Excel 365, which cell reference type allows the cell reference in the formula to
reflect the new location after a formula is copied and pasted to another cell?

Ans 1. Mixed cell reference

2. Absolute cell reference

3. Relative cell reference

4. Circular cell reference

Question ID : 264330182115
Option 1 ID : 264330714301
Option 2 ID : 264330714300
Option 3 ID : 264330714299
Option 4 ID : 264330714302

Status : Answered
Chosen Option : 1
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